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1. OBJETIVO Y ALCANCE 

Definir las especificaciones técnicas, procedimientos y herramientas para la generación de las salidas 

gráficas de los planos de conjunto, cartas catastrales tanto urbanas como rurales y de igual manera, para 

planos de zonas homogéneas físicas y geoeconómicas tanto urbanos como rurales de acuerdo a la 

normatividad, política y estándares de calidad determinados por la Subdirección de Catastro. 

Este instructivo aplica para el equipo técnico y profesional encargado de la elaboración de los productos 
catastrales en todas las Direcciones Territoriales y Unidades Operativas de Catastro que aún no se han 
incorporado al Sistema Nacional catastral. 

 

Inicia a partir de la solicitud del producto catastral por parte del cliente y culmina con la entrega en 
formato digital o análogo del mismo. 

 

2. GLOSARIO1 

Carta Catastral Rural Es el documento cartográfico georeferenciado en el que se encuentran 
individualizados los predios que conforman la zona rural de la unidad 
orgánica catastral y la delimitación e identificación de los sectores, 
veredas catastrales, límite municipal y perímetro urbano. 

Carta Catastral Urbana Es el documento cartográfico georeferenciado en el que se encuentran 
individualizados los predios y construcciones que conforman la manzana 
catastral de la zona urbana de la unidad orgánica catastral con su 
respectiva identificación, nomenclatura vial y domiciliaria. 

Plano de Conjunto Rural Es el documento cartográfico georeferenciado con demarcación del límite 
municipal, perímetros urbanos, sectores y veredas catastrales. 

Plano de Conjunto Urbano Es el documento cartográfico georeferenciado con delimitación del 
perímetro urbano, identificación del sector, comuna, barrio, manzana y 
nomenclatura vial. 

Plano de Zonas Homogéneas 
Físicas 
 

Es el documento cartográfico georeferenciado con la delimitación de 
espacios geográficos de características similares en cuanto a vías, 
topografía, servicios públicos, uso actual del suelo, norma de uso del 
suelo, tipificación de las construcciones y/o edificaciones, áreas 
homogéneas de tierra, disponibilidad de aguas superficiales 
permanentes u otras variables que permitan diferenciar éstas áreas de 
las adyacentes. 

Plano de Zonas Homogéneas 
Geoeconómicas 

Es el documento cartográfico georeferenciado con la delimitación de los 
espacios geográficos determinados a partir de Zonas Homogéneas 
Físicas que presentan valores unitarios similares en cuanto a su precio, 
según las condiciones del mercado inmobiliario. 

 

 

                                                           
1 Los conceptos referidos en esta sección fueron tomados de la “Resolución 70_2011” del IGAC. 
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3. NORMAS DE PROCEDIMIENTO, LINEAMIENTOS O POLÍTICAS DE OPERACIÓN 

3.1. GENERALES Y DE CONTROL 

° Se debe garantizar que las plantillas que se utilicen para generar las salidas gráficas de los 
diferentes productos correspondan a las versiones actualizadas que suministra la Subdirección de 
Catastro. 

° El funcionario responsable de generar estos productos deberá atender las especificaciones del 
presente instructivo a fin de disminuir la posibilidad de errores y garantizar la consistencia y 
veracidad de la información. 

4. PROCEDIMIENTO- OPERACIÓN 

4.1. INFORMACIÓN CARTOGRÁFICA CATASTRAL 

Para el manejo de la información cartográfica catastral existe una base de datos geográfica única 
por municipio, esta se divide en zona urbana y rural y a su vez la zona urbana puede estar 
compuesta de cabecera municipal y corregimientos, estos últimos para catastro corresponden a 
una numeración del componente zona diferente, tal como aparece en la tabla 2. 

El componente Zona de la unidad orgánica catastral: El componente zona de una unidad 
Orgánica catastral se dividirá en urbana y rural, según se trate del área comprendida dentro o 
fuera del perímetro urbano respectivamente, y el cual debe estar debidamente aprobado por la 
autoridad competente. 

Según el modelo de datos de la base de datos geográfica catastral, el componente zona 
corresponde a la posición 6 y 7 del código de 30 posiciones, tal como se puede apreciar en la 
Tabla 1. 

Tabla 1. Componentes del código único predial catastral 

DPTO MPIO ZONA SECTOR COMUNA BARRIO MANZANA O VEREDA TERRENO 
CONDICIÓN 

DE PREDIO 

NÚMERO DE CONSTRUCCIÓN / PH 

No. del 
EDIFICIO 
O TORRE 

No. DEL 
PISO 

DENTRO 
DEL 

EDIFICIO 
O TORRE 

No. DE UNIDAD EN PH,  
CONDOMINIO O 

MEJORA 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 

 

Tabla 2. Componente ZONA 

CÓDIGO ZONA 

00 Rural 

01 Cabecera 

≥ 02 Corregimiento 
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4.2. CARACTERIZACIÓN DE LOS PRODUCTOS CARTOGRÁFICOS CATASTRALES 

4.2.1. Plano de conjunto urbano 

Tabla 3: Caracterización del plano de conjunto urbano 

ZONA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Urbana 
Plano de 

Conjunto 

En este producto se representa gráficamente: La 

delimitación del perímetro urbano, identificación de 

la sectorización urbana, nomenclatura vial y la 

totalidad de las manzanas de la Cabecera Municipal 

o Corregimiento de un municipio. Su escala y 

número de planchas es variable. 

1:1.000 

A 

1:10.000 

 

 

Solo múltiplos de 

1000 

OPCIÓN 1 

PDF 

300 Dpi 

tamaño de impresión  

85 x 85 cm vertical 

 

OPCIÓN 2 

PDF 

300 Dpi 

tamaño de impresión 90 

x 90 cm horizontal 

° Formato Plano de Conjunto Urbano: Mapa escalas: 1:1.000 a 1:10.000 

Las medidas se dan en centímetros y las dimensiones de las cajas siempre indican ancho x alto. 
Los valores entre paréntesis expresan distancias en X y Y con respecto a la esquina inferior 
izquierda del papel [origen (0,0)], Figura 1. 

- Formato vertical 

-  

Figura 1. Formato Opción 1. 
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- Formato horizontal 

 

Figura 2. Formato Opción 2. 

- Configuración de Etiquetas y Símbolos para la salida gráfica  

Tabla 4: Propiedades de Etiquetas y símbolos para el producto Plano de Conjunto Urbano 

PLANO DE CONJUNTO URBANO 

ESCALA COBERTURA 

ETIQUETA SÍMBOLO 

TAMAÑO FUENTE 

COLOR 

FUENTE 

RGB 

TIPO TAMAÑO 
COLOR LÍNEA  

RGB 

1.000 
A 

10.000 

U_PERIMETRO SIN SIN SIN LÍNEADISCONTINUA 2 (255,0,0) 

U_SECTOR 8,00 ARIAL (0,0,0) LÍNEA DISCONTINUA 2,00 (230,0,0) 

U_MANZANA 7,00 ARIAL (115,0,0) LÍNEACONTINUA 1,20 (38,115,0) 

U_TERRENO 4,5 ARIAL (0,0,0) LÍNEA CONTINUA 0,20 (79,87,122) 

U_NOMENCLATURA_VIAL 5.00 ARIAL (104,104,104) SIN SIN SIN 

VIA 5,00 ARIAL (0,0,0) LÍNEA CONTINUA 2,00 
DEGRADADO DE 

COLORES SEGÚN 
TIPO DE VÍA 

DRENAJE SENCILLO 5,00 ARIAL (0,0,0) LÍNEA CONTINUA 1,00 (0,112,255) 

VIA_FERREA 7,00 ARIAL (0,0,0) LÍNEA CONTINUA 2,00 (0,0,0) 

CANAL_DOBLE 8,00 ARIAL (0,0,0) POLÍGONO 8,00 
(190,15,96) 

CONTORNO 
(110,110,110) 

PARQUE 6,00 ARIAL (0,0,0) LÍNEA CONTINUA 0,40 (51,8,93) 

DRENAJE_DOBLE 7,00 ARIAL (0,0,0) POLÍGONO 0,40 

RELLENO 
(183,237,250), 
CONTORNO 
(115,223,255) 
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Nota 1: La leyenda y convenciones para los ítems de cartografía básica son los definidos para la 
representación establecida por la Subdirección de Geografía y Cartografía. 

Nota 2: El tamaño de la etiqueta y el tamaño del símbolo para las escalas inferiores a 10.000 se 
modifican proporcionalmente a la escala de generación. 

Nota 3: La cartografía básica digital utilizada en este producto es la generada por la Subdirección 
de Geografía y Cartografía para áreas urbanas con escala generalmente 1:2.000 o superiores. 

4.2.1.1. Generación plano de conjunto Urbano. 

El plano de conjunto urbano se elabora solicitud del mismo, se deben configurar las escalas 
adecuadas que permitan ver la información completa y entendible; sin excepción se genera 
utilizando las plantillas suministradas de manera oficial por la Subdirección de Catastro. A 
continuación se relacionan los pasos a seguir para su generación. 

1) Abrir la plantilla PLANO_CONJUNTO_URBANO.mxd 

Se encuentran cuatro opciones: 

 Vertical 1:1.000 (Se utiliza para escalas de 1:1.000 a 1:4.000). 

 Vertical 1:5.000 (Se utiliza para escalas de 1:5.000 a 1:10.000). 

 Horizontal 1:1.000 (Se utiliza para escalas de 1:1.000 a 1:4.000). 

 Horizontal 1:5.000 (Se utiliza para escalas de 1:5.000 a 1:10.000). 

2) Direccionar el Data Source de las diferentes capas ->Clic en botón derecho sobre cualquiera de 
las capas ->Data->Repair Data Source (Figura 3) y buscar la ruta dentro de la base de datos que 
corresponde al Feature seleccionado, este paso se realiza tanto para las capas de la base 
catastral como la de cartografía básica digital urbana. 

Figura 3. Direccionamiento de capas. 



    
INSTRUCTIVO 

GENERACIÓN DE SALIDAS GRÁFICAS DE LOS PRODUCTOS 
CATASTRALES  

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 6 de 73 

Cód. I51600-02/17.V1 

Fecha Mayo de 2017 

 

 COPIA NO CONTROLADA 

 
 

3) Dar clic sobre view y después sobre data frame properties en el Data Frame seleccione Extent 
Automatic (Figura 4). 

 

Figura 4. Selección de extent. 

4) Ubicar las Manzanas a las cuales se le va a generar el plano de conjunto, en la capa de 
perímetro clic derecho ->open attribute table->y seleccione el perímetro correspondiente a la 
zona que se va trabajar (Ver tabla 2), en este caso la zona 01 (CABECERA MUNICIPAL) y 
después clic sobre Zoom To Selected (Figura 5). 

 

Figura 5. Selección de área de trabajo. 

5) Defina la escala degeneración de tal forma que el frame abarque toda el área del municipio a 
trabajar (Figura 6). 

 

Figura 6. Definir Escala de generación. 
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6) Si con la escala de generación máxima (1:10.000) no logra abarcar el cubrimiento total del 
municipio se deberá generar más de un plano de conjunto para este, siendo necesario evaluar la 
escala de generación y se debe generar el número de grillas necesarias teniendo en cuenta el 
tamaño del frame, clic derecho sobre el frame, properties, Size and Position (Figura 7).  

 

Figura 7. Tamaño del frame. 

El tamaño del frame es Width 75 cm y Height 50 cm, Para una escala de generación 1:10.000 las 
dimensiones de las grillas son: 

 Width = tamaño del frame por factor escala en metros (0.75 m x 10.000 = 7.500 m). 

 Height = tamaño del frame por factor escala en metros (0.5 m x 10.000 = 5.000 m). 

7) Antes de generar las grillas se debe tener en cuenta que solo se va generar para la cabecera 
municipal, clic derecho sobre perímetro ->open attribute table y seleccione el perímetro 
correspondiente a la zona 01 (CABECERA MUNICIPAL), Después clic derecho sobre perímetro -
>Data ->Export Data, guarde el SHP en la ruta correspondiente y OK (Figura 8). 

 

Figura 8. Export SHP para el Perímetro de la Cabecera 
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Para generar las grillas hay que darclic en Arc Toolbox Windows-> 

Posteriormente clic en->Data Management Tools->Feature Class y doble clic en Create Fishnet 

(Figura 9). 

 

Figura 9. Generación de grilla. 

8) Después se despliega un cuadro de dialogo al cual se le van ingresar los siguientes datos (Figura 
10). 

 Output Feature Class = Ruta de salida. 

 Template Extent (optional) = SHP del Perímetro de la Cabecera. 

 Cell Size Width = El tamaño de la grilla en este caso es 7.500. Ver Figura 7. 

 Cell Size Height = El tamaño de la grilla en este caso es 5.000. Ver Figura 7. 

 Number of Rows = El número de filas en este caso es 1 depende de la forma de la Cabecera. 

 Number of Columns = El número de Columnas en este caso es 2 depende de la forma de la 
Cabecera. 

 Create Etiqueta of Fishnet (optional) = Debe estar desactivado. 

 Geometry Type (optional) = POLYGON 
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Figura 10. Cuadro de dialogo para la generación de la grilla. 

9) Procedemos a editarlas grillas para cambiar su ubicación teniendo en cuenta la forma del 
municipio (Figura 11). 

 

Figura 11. Edición de las grillas. 
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10) Con la herramienta Edit tool ubicar las grillas de tal forma que la información del frame 
permanezca proporcional (Figura 12). 

 

Figura 12. Ubicación de las grillas. 
 

11) Seleccione la primera grilla a generar y dar clic derecho a la grilla que está ubicada en: Table of 
contents ->Selection->Zoom To Selected Features (Figura 13). 

 

Figura 13. Zoom sobre la grilla a trabajar. 
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12) Después se ajusta la escala de generación en este caso a 1:10.000 (Figura 14). 

 

Figura 14. Ajuste de escala de generación. 

13) Para la información que se suministra en el INDICE cuando se genera más de una plancha es 
necesario suministrar la información de la grilla y modificar la información en el frame para el 
INDICE (Figura 15). 

 

Figura 15. Información del INDICE. 
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14) Se deben verificar que los intervalos sean coherentes con la escala de generación, este valor 
debe ser el 10% de la escala de la plancha a generar, es decir, para la escala 1:10.000 debe ser 
cada 1.000 metros y para la escala 1:5.000 debe ser cada 500 metros, este procedimiento se 
realiza de la siguiente forma, clic derecho sobre: el Frame->Properties->Grids->Properties-
>intervals. (Figura 16). 

 

Figura 16. Intervalos de la grilla. 

15) Ajuste de la información marginal, este procedimiento se encuentra descrito en la sección 4.2 de 
este documento, por favor consulte este ítem y aplicar a la plantilla trabajada. 

16) Exportar a pdf, en las rutas de almacenamiento definidas una vez realizado todo el procedimiento 
anteriormente descrito con las características definidas en la Tabla 2 (Identificación del producto 
Plano de Conjunto Urbano), nombrar el archivo como 
“PLANO_DE_CONJUNTO_URBANO_XXXXXXX” donde XXXXXXX corresponde a la 

especificación descrita en la Tabla 5:  

Tabla 5. Campos de Identificación del Producto 

 
 

 

Adicional a lo anterior cuando se crean grillas deberá nombrarse como “XXXXXXX_n_de_N” donde 
n es el índice creado y N el total de grillas que ocupan el municipio. 

 

 

 

X X X X X X X  

Departamento Municipio Zona 
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4.2.2. Plano de conjunto rural 

Tabla 6. Identificación del plano de conjunto rural. 

ÁREA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Rural 
Plano de 
Conjunto 

En este producto se representa gráficamente la 
delimitación del perímetro urbano, la identificación de 
la sectorización rural, la nomenclatura vial y la 
totalidad de las veredas de un municipio. Su escala y 
número de planchas es variable. 

Ajustable 

OPCIÓN 1 
PDF 
300 dpi 
tamaño de impresión 
85 x 85 cm vertical 
 
 
OPCIÓN 2 
PDF 
300 dpi 
tamaño de impresión 
90 x 90 cm horizontal 

° Formato Plano de Conjunto Rural: Las escalas de salida dependen del tamaño del municipio. 

Las medidas se dan en centímetros y las dimensiones de las cajas siempre indican ancho x 
alto. Los valores entre paréntesis expresan distancias en X y Y con respecto a la esquina 

inferior izquierda del papel [origen (0,0)], Figura 17. 

­ Formato vertical 

 

Figura 17. Formato Opción 1. 
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- Formato horizontal  

 

Figura 18. Formato Opción 2 

- Configuración de Etiquetas y Símbolos para la salida gráfica. 

Tabla 7: Propiedades de Etiquetas y símbolos para el producto Plano de Conjunto Rural. 

PLANO DE CONJUNTO RURAL 

ESCALA 
COBERTURA 

ETIQUETA SÍMBOLO 

TAMAÑO FUENTE 
COLOR 
FUENTE 

RGB 
TIPO TAMAÑO 

COLOR LÍNEA  
RGB 

1:10.000 

U_PERIMETRO SIN SIN SIN LÍNEA DISCONTINUA 2 (255,0,0) 

R_SECTOR 8,00 ARIAL (0,0,0) LÍNEA DISCONTINUA 2,00 (230,0,0) 

R_VEREDA 7,00 ARIAL (115,0,0) LÍNEA CONTINUA 1,20 (38,115,0) 

R_NOMENCLATURA_VIAL 5.00 ARIAL (104,104,104) SIN SIN SIN 

VIA 5,00 ARIAL (0,0,0) LÍNEA CONTINUA 2,00 

DEGRADADO DE 
COLORES 

SEGÚN TIPO DE 
VÍA 

DRENAJE_DOBLE 7,00 ARIAL (0,0,0) POLÍGONO 0,40 

RELLENO 
(151,219,242), 
CONTORNO 
(64,101,235) 

DRENAJE_SENCILLO 5,00 ARIAL (0,0,0) LÍNEA CONTINUA 1,00 (0,112,255) 

VIA_FERREA 7,00 ARIAL (0,0,0) LÍNEA CONTINUA 2,00 (0,0,0) 

 
PARQUE_R 

5,00 ARIAL (104,104,104) LÍNEA CONTINUA 0,40 (233,255,299) 
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 Nota 1: La leyenda y convenciones para la cartografía básica, son definidas por la 
representación establecida por la Subdirección de Geografía y Cartografía. 

 Nota 2: El tamaño del Etiqueta y el Tamaño del símbolo está definido para la escala 1:10.000, 
para otras escalas se modifica proporcionalmente a la escala de generación. 

 Nota 3: La cartografía básica digital utilizada en este producto es la generada por la Subdirección 
de Geografía y Cartografía generalmente a escala 1:10.000 y/o 1:25.000. 

4.2.2.1. Generación plano de conjunto rural 

El plano de conjunto rural se elabora de acuerdo a las necesidades, se deben configurar las 
escalas adecuadas que permitan ver la información completa y entendible. El plano de 
conjunto rural se genera utilizando las plantillas suministradas de manera oficial por la 
Subdirección de Catastro. 

Abrir la plantilla PLANO_CONJUNTO_RURAL.mxd 

A. Se encuentran cuatro opciones: 

 Vertical 1:5.000 (Se utiliza para escalas de 1:5.000 a 1:20.000). 

 Vertical 1:25.000 (Se utiliza para escalas de 1:21.000 y Escalas superiores a 1:21.000). 

 Horizontal 1:5.000 (Se utiliza para escalas de 1:5.000 a 1:20.000). 

 Horizontal 1:25.000 (Se utiliza para escalas de 1:21.000 y Escalas superiores a 
1:21.000). 

B. El plano de conjunto Rural se genera de igual forma que como se explicó para el plano de 
conjunto urbano, es decir, su generación es análoga. (Ver sección anterior). 

4.2.3. Carta Catastral Urbana. 

Este producto cuenta con la posibilidad de generarlo tanto en formato pdf como análogo, de 
acuerdo a los requerimientos de los usuarios en la tabla 6 se definen las características de la 
carta catastral urbana para el formato pdf. 

Tabla 8: Identificación del producto Carta Catastral urbana 

ÁREA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Urbana Carta Catastral 

 
En este producto se representa gráficamente la 
localización de los predios urbanos que forman una 
manzana catastral con sus respectivos linderos, 
construcciones y códigos de identificación catastral, 
elaborado a escala variable. 
 
 

1:250 
1:500 

1:1.000 

PDF  
300 Dpi 
Tamaño de impresión 
55 x 45 cm horizontal 

° Formato Carta Catastral Urbana: Mapas escala 1:250,1:500 y 1:1000. 

Las medidas se dan en centímetros y las dimensiones de las cajas siempre indican ancho x alto. 
Los valores entre paréntesis expresan distancias en X y Y con respecto a la esquina inferior 

izquierda del papel [origen (0,0)], (Figura 19). 
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Figura 19. Formato para Carta Catastral Urbana. 

 

Tabla 9: Propiedades de Etiquetas y símbolos para el producto Carta Catastral Urbana 

CARTA CATASTRAL URBANA 

ESCALA COBERTURA 

ETIQUETA SÍMBOLO 

TAMAÑO FUENTE 
COLOR 
FUENTE 

RGB 
TIPO LÍNEA 

COLOR LÍNEA  
RGB 

250 
 500 
1000 

U_MANZANA 9 ARIAL (NEGRITA) (38,115,0) LÍNEA CONTINUA 1 (0,38,115) 

U_TERRENO 8 ARIAL (0,0,0) LÍNEA CONTINUA 0,4 (0,0,0) 

U_CONSTRUCCION 
CONVENCIONAL 

 
U_CONSTRUCCION 
NO CONVENCIONAL 

6 ARIAL (0,0,0) 
POLÍGONO ACHURADO 

ANGULO 45°, 
SEPARACIÓN 5 

0,4 (255,0,0) 

6 ARIAL (0,0,0) 
POLÍGONO ACHURADO 

ANGULO 45°, 
SEPARACIÓN 5 

0.4 (197,0,255) 

U_UNIDAD 6 ARIAL (0,0,0) LÍNEA CONTINUA 0,4 (0,0,0) 

U_NOMENCLATURA 
DOMICILIARIA 

5 ARIAL (0,0,0) SIN SIN SIN 

U_NOMENCLATURA VIAL 8 ARIAL (NEGRITA) (0,0,0) SIN SIN SIN 

U_PERIMETRO SIN SIN SIN 
LÍNEA SEGMENTADA Y 

SÍMBOLO ∆ 
8 (255,0,0) 

U_SECTOR SIN SIN SIN 
LÍNEA SEGMENTADA Y 

PUNTOS 
5 (255,0,0) 

U_COTAS 4 ARIAL (0,0,0) SIN SIN SIN 

DRENAJE_DOBLE 9 ARIAL (0,0,0) POLÍGONO 0,4 

RELLENO 
(151,219,242), 
CONTORNO 
(64,101,235) 

DRENAJE_SENCILLO 9 ARIAL CURSIVA (0,0,0) LÍNEA CONTINUA 1 (163,242,242) 

VIA_FERREA 8 ARIAL (0,0,0) LÍNEA CONTINUA 4 (0,0,0) 

PARQUE_R 8 ARIAL (104,104,104) LÍNEA CONTINUA 0,4 (130,130,130) 
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4.2.3.1. Aspectos generales a consideraren la generación de la Carta Catastral Urbana 

Este proceso se realiza en forma individual y masiva a escala 1:500; en este último caso si el 
sistema no puede generar la Carta Catastral Urbana a la escala programada, en la caja de 
dialogo donde aparecen los códigos de las manzanas quedan relacionadas aquellas que no se 
pudieron realizar, para que posteriormente y de manera individual se defina cómo generarlas. 

- En caso de tener varias cartas para una manzana, se debe hacer el gráfico respectivo en el 
área índice de planchas, numerando cada plancha en su conjunto para referenciar la 
distribución del conjunto de cartas que conforman la manzana; de igual forma se debe 
modificar la identificación de la plancha dependiendo del número que se le asigne con 
respecto al total de las cartas que conforman la manzana, puesto que, esta numeración se 
hace manualmente (Ej.: Plancha 1 de 4).  

- Como la plantilla se genera para cartas catastrales escala 1:500, en el momento que se 
tenga que modificar la escala (Las escalas más utilizadas son 1:100, 1:200, 1:250, 1:500 y 
1:1.000), se debe cambiar el intervalo de la grilla para que quede al 10% de la escala 
(ejemplo: para escala 1:250 el intervalo debe ser de 25m); de igual forma se debe modificar 
la escala gráfica para que en el tamaño el valor de la división sea del 1% de la escala 
(ejemplo: para escala 1:250 el valor de la división debe ser de 2,5m). 

- Se recomienda utilizar la extensión maplex para que todas las etiquetas se organicen de la 
mejor manera posible, sin tener casos de superposiciones. 

- Para no congestionar el dibujo, se deben eliminar los acotados que tengan “longitud” 
menor a 1m; también se deben eliminar las cotas en segmentos curvos que presenten 
demasiados nodos. Se recomienda que en escalas 1:1.000 se disminuya un poco el 
tamaño de las etiquetas para que no se superpongan y en caso de no identificarse bien la 
información, se recomienda representar la manzana en varias cartas catastrales a una 
escala detallada.  

- Para polígonos muy pequeños, como algunos volados o edificaciones, se recomienda no 
generarles Etiquetas.  

4.2.4. Generación de la Carta Catastral Urbana Individual 

I. Instalación del aplicativo 

El aplicativo para la carta Catastral; consta de dos archivos ejecutables en el cual se da doble clic 
(Figura 20). 

 

 

Figura 20. Ejecutables para la generación de la Carta Catastral. 
 

II. Luego aparece el siguiente cuadro en el cual se escoge la opción Install Add-In, con la cual se 
instala el aplicativo (Figura 21). 

 

 

 

 



    
INSTRUCTIVO 

GENERACIÓN DE SALIDAS GRÁFICAS DE LOS PRODUCTOS 
CATASTRALES  

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 18 de 73 

Cód. I51600-02/17.V1 

Fecha Mayo de 2017 

 

 COPIA NO CONTROLADA 

 
 

 

 

 

 

 

 

Figura 21. Selección del Add-In  

Si la instalación fue correcta aparece el siguiente mensaje (Figura 22). 

 

 

 

 

 

Figura 22. Mensaje de instalación satisfactoria. 

III. Después en ArcMap se abre el menú Customize->Toolbars->Customize (Figura 23). 

 

Figura 23. Personalización de la barra de herramientas. 
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IV. Posteriormente en la ventana Customize se elige la pestaña comando ->Add-In Controls y allí se 
encuentran los botones Con los iconos: ->del aplicativo de la Carta Catastral individual y Carta 
Catastral Masiva. 

 

Este se incorpora a la barra de herramientas en la que se desee ubicar (Figura 24). 

 

 

 

 

 
 

 

 

 

 

Figura 24. Selección del aplicativo de generación de la Carta Catastral. 

V. Para la generación Individual se debe abrir en ArcMap el archivo 
CARTA_CATASTRAL_URBANA.mxd que contiene la plantilla generada para la carta catastral 
(Figura 25). 

 

Figura 25. Plantilla de la carta catastral. 
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4.2.5. Direccionamiento de información a la Base de Datos Corporativa Local 

Antes de direccionar la información de la base de datos, se debe realizar una conexión a la base 
de datos corporativa local. 

4.2.5.1. Conexión Base de Datos Corporativa Local:2 

Para la conectarse a la base de datos espacial3en el motor de base de datos Postgres puede 
realizarse por una conexión a partir de un servicio SDE a la geodatabase. 

Esta conexión se ejecuta en cada uno de los equipos de los usuarios que se van a conectar a la 
geodata base corporativa, por lo tanto exige que la estación de trabajo del usuario tenga 
instalado una ArcGIS Desktop 10. Para realizar el procedimiento se debe hacer lo siguiente: 
 
I. En la estación de trabajo del usuario abrir una ventana de ArcCatalog. 

II. En el árbol de catálogo abrir la carpeta de Database Connections y seleccionar la opción 
Add Spatial Database Connection como se muestra en la siguiente (Figura 26) 

 

Figura 26. Árbol De ArcCatalog Para Crear Conexión Base de Datos Espacial 

 
III. Hacer doble clic en Add Spatial Database Connection, esto abrirá el cuadro de diálogo 

como se muestra a continuación: (Figura 27) 

                                                           
2Toda la información consignada en este Ítem se encuentra detallada en el Instructivo_Administración_base_de_ Datos Corporativa _TR_02_08_2012, 
ubicado en la ruta : FTP DANE /APOYOCENTRAL/OTROS/IMPLEMENTACION_BD_CORPORATIVA/DOCUMENTACION 
3 Una conexión de base de datos espacial crea un archivo en el equipo del cliente que contiene la información de conexión a una geodatabase de 
ArcSDE. 
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Figura 27. Cuadro de Dialogo Spatial Database Connection 

IV. Se debe diligenciar el cuadro de texto Service, se debe digitar sde: postgresql: 
XXX.XX.XX.X, donde, XXX.XX.XX.X corresponde a la IP del servidor de bases de datos4 . 
En el ítem Database se debe colocar el nombre de la base de datos a la que se desea 
conectar y finalmente en el frame Account en los ítem Username y password se digita el 
usuario y contraseña del rol que va a hacer la conexión. Como se observa a en el siguiente 
ejemplo la base de datos sobre la que se realiza la conexión es gdb_20011_np, la IP del 
servidor de base de datos es 172.16.69.6, el usuario que se conecta a la base de datos es el 
súper usuario de sde, y finalmente la versión5 a la que se conecta el usuario sde es la 
versión DEFAULT6.(Figura 28) 

 

Figura 28. Cuadro de Dialogo Ejemplo Spatial Database Connection 

V. Se hace clic en el TestConnection, si la conexión ejecutó correctamente aparecerá el 
mensaje como el que se ve en la siguiente figura, si aparece otro mensaje se debe 

                                                           
4Para garantizar la correcta ejecución de la conexión la dirección IP del equipo que se quiere conectar a la base de datos debió ser previamente colocada en el 

archivo pg_hba.conf 
5Una versión representa una instantánea en el tiempo de la geodatabase completa y contiene todos los dataset de la geodatabase. Las versiones no son copias 

separadas de la geodatabase. En su lugar, se realiza el seguimiento en tablas del sistema de las versiones y de las transacciones que tienen lugar dentro de ellas 

6Versión default, es la versión raíz de la base de datos, siempre existe 
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revisar nuevamente los parámetros de conexión o evaluar si el servidor de base de datos 
esté disponible para la conexión. (Figura 29). 

 

Figura 29. Conexión establecida 

VI. Cuando se hace clic en Aceptar al mensaje emergente y OK al cuadro de dialogo, se 
genera la conexión con un nombre genérico como se observa en la (figura 30), este debe 
ser cambiado por el siguiente estándar gdb_ddmmm_np_nnnn_@%%%%%%, donde 
gdb_ddmmm_np es el nombre de la base de datos a la que se está conectando; 

“nnnn” es el nombre del usuario que se conecta a la base de datos y con el que se 
realiza la autenticación de la conexión, por ultimo %%%%%%% es la versión a la que se 
está realizando la conexión. 

Como se observa en el siguiente ejemplo (figura 31) la conexión 
gdb_20011_np_sde@default, está especificando que la misma es sobre la base de 
datos gdb_20011_np, el usuario que se conecto es sde y la versión a la que está 
conectado es la default. La estandarización del nombre de la conexión permite ahorrar 
tiempo cuando en un equipo se debe generar más de una conexión, ya que no se 
requiere abrir la ventana de propiedades de la conexión para conocer el detalle de la 
misma. 

                            Figura 30. Conexión por defecto                                                     Figura 31. Conexión Renombrada 

VII. Direccionamiento Base de Datos Corporativa Local de la Conexión Creada (Figura 32) 

Por medio de ArcMap en la pestaña Add Data se selecciona la conexión de la base de datos de 
la cual se va a generar la salida gráfica.  
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Posteriormente se seleccionan los Features del Dataset Urbano para la generación de la carta 
catastral. (Figura 33). 

 

Figura 32. Conexión base de datos Corporativa local. 

 

Figura 33. Selección de Datos de la Geodatabase a trabajar. 

VIII. Paso seguido se pulsa el botón del aplicativo  y se realiza lo siguiente (Figura 34). 

 Se selecciona la manzana para la cual se desea generarla Carta Catastral. 

 Se da clic en el botón Configurar Datos Generales. 
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 Se diligencian los datos de la sección Datos Territorial (Territorial, Departamento, 
Municipio, Vigencia (formato: día/mes/año), Fuente7). 

 

Figura 34. Diligenciamiento de datos generales. 

IX. Finalmente se da clic en el botón Actualizar (Figura 35). 

 

Figura 35. Actualización de datos generales. 

X. Luego que la información de la manzana ha sido actualizada en la plantilla aparece el 
mensaje de que el proceso ha terminado (Figura 36). 

                                                           
7
La fuente corresponde al método de levantamiento de la información de la manzana, es decir, por levantamiento topográfico, cotas, 

levantamiento con Cinta etc. 
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Figura 36. Confirmación de terminación del proceso de actualización. 

XI. Ahora se selecciona el botón Generar pdf y automáticamente se genera el archivo pdf 
para la manzana seleccionada; el cual queda almacenado en la ruta que aparece 
especificada en el mensaje que indica que el proceso de creación del archivo pdf fue 
exitoso (Figura 37). 

 

Figura 37. Mensaje de generación exitosa del PDF. 

Nota 1: El aplicativo genera automáticamente la ruta donde quedan almacenados los pdf, se crea 
una carpeta por municipio, (Figura .38-a). También se crea en C: una carpeta temporal que 
guarda los archivos que se generan en la ejecución del aplicativo (Figura 38-b). 

 

 

 

 

 

 

 

 

Figura 38-a. Ruta donde se guardó el pdf generado.   Figura 38-b. Ubicación de archivos temporales. 
 

XII. Luego de Actualizar y Generar el pdf de una manzana; automáticamente el aplicativo 
pasa a la siguiente manzana para realizar el proceso. Si se desea realizar el proceso 
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para otra manzana diferente, ésta se selecciona del menú desplegable Manzana No. 
(Figura 39). 

 

Figura 39. Selección de otra manzana para realizar el proceso. 

XIII. El aspecto y estructura de una carta catastral generada empleando el aplicativo se ilustra 
en la Figura 40. 

 

Figura 40. Carta catastral generada a través del aplicativo. 
 

XIV. El archivo generado se guarda en la ruta por defecto 
C:\IGAC\CARTAS\nombre_Departamento Con la estructura del código de 20 
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posiciones hasta el número de manzana seguido de un guion y la fecha de generación: 
=> , para el caso del ejemplo es una manzana del municipio de Barranquilla: 

 

Tabla 10: Estructura código de 20 posiciones para la carta catastral  

CODIGO 
DEPARTAMENTO 

CODIGO 
MUNICIPIO 

ZONA SECTOR COMUNA BARRIO 
MANZANA O 

VEREDA 

0 8 0 0 1 0 1 0 1 0 0 0 0 0 0 0 1 

Cuando se finalice el proceso de generar las manzanas catastrales, se cierra la ventana 
del aplicativo y no se deben guardar los cambios generados en el archivo 
CARTA_CATASTRAL_URBANA.mxd, para que el archivo mxd no pierda su 
configuración inicial. 

XV. En algunos casos la carta catastral que se genera no presenta congruencia entre los 
elementos graficados y la leyenda. Por ejemplo la manzana 08001030000000032 
presenta este comportamiento, aquí todas las construcciones fueron graficadas sin 
atributo (Figura 41). 

 

Figura 41. Manzana con códigos de atributos en U_Unidad vacíos 

XVI. Para solucionar este inconveniente se oprime el botón Construcción (Figura 42). 

 

Figura 42. Corrección de la representación de las unidades. 

XVII. Como resultado de la anterior acción, la capa construcción se graficó correctamente 
(Figura 43). 
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Figura 43. Carta Catastral generada correctamente después del ajuste de construcción. 

XVIII. Después de verificar se procede a generar el archivo en formato pdf de la Carta 
Catastral. 

4.2.6. Generación masiva de la Carta Catastral Urbana 

I. Para la generación Masiva se debe abrir en ArcMap el archivo .mxd que contiene la 
plantilla generada para la carta catastral masiva (Figura 44). 

 

 

Figura 44. Plantilla de la Carta Catastral. 
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II. Posteriormente se debe direccionar la información a la Geodatabase Corporativa a 
trabajar (Figura 45), Ver Ítem 3.3.2.5.1 Conexión Base de Datos Corporativa Local 
(Página 22)  

 

Figura 45. Ubicación Geodatabase a trabajar. 

III. Paso seguido se pica el botón del aplicativo  y se realiza lo siguiente (Figura 46). 

 

Figura 46. Aplicativo para generar masivamente la Carta Catastral. 
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 Se despliega el listado Manzana No.; con ayuda del botón  se cargan las 
manzanas de las cuales se desean generar su respectiva carta catastral. 

 Se da clic en el botón Configurar Datos Generales. 

 Se diligencian los datos de la sección Datos Territorial (Territorial, Departamento, 
Municipio, Vigencia (formato día/mes/año), Fuente8) 

Nota 1: El botón  Permite seleccionar una manzana y eliminarla de la lista de cartas 

catastrales a generar. El botón  tiene la función de limpiar completamente la lista de 
manzanas que con anterioridad habían sido seleccionadas para generar cartas catastrales. 
Cuando una manzana ya seleccionada se intenta seleccionar de nuevo, aparece el siguiente 
mensaje (Figura 47). 

 

Figura 47. Mensaje de doble selección de una manzana. 

IV. Finalmente se da clic en el botón Generar (Figura 48). 

 

Figura 48. Avance en el proceso de generación. 

                                                           
8
La fuente corresponde al método de levantamiento de la información de la manzana, es decir, por levantamiento topográfico, cotas, 

levantamiento con Cinta etc. 
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V. A medida que el aplicativo va generando las cartas catastrales, va indicando el número 
de cartas procesadas (Figura 49). 

 

Figura 49. Informe de Cartas Catastrales Generadas. 

VI. Al finalizar por completo la generación de cartas catastrales aparece un mensaje que 
confirma que el proceso fue exitoso (Figura 50). 

 

Figura 50. Mensaje de terminación exitosa del proceso. 
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VII. Al igual que ocurre en la generación de cartas catastrales en forma individual, los 
archivos formato pdf de cada una de las cartas generadas quedan almacenados en la 
ruta por defecto: C:\IGAC\CARTAS\codigo_municipio(Figura 51). 

 

Figura 51. Ubicación de los archivos PDF generados. 

VIII. El aspecto y estructura de las cartas catastrales generadas masivamente empleando el 
aplicativo se ilustra en la (Figura 52). 

 

Figura 52. Salida gráfica de Cartas Catastrales. 
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Nota 2: Cuando se finalice el proceso de generar las manzanas catastrales, se cierra la ventana 
del aplicativo y después ArcMap sin guardar los cambios generados en el archivo 
CARTA_CATASTRAL_URBANA.mxd 

El archivo generado se guarda en la ruta por defecto C:\IGAC\CARTAS\nombre_Departamento: 

=>Con la estructura del código catastral hasta el número de manzana seguido de un guion y la fecha de 
generación, para el caso del ejemplo es una manzana del municipio de Ibagué Departamento del Tolima 
generada el 22-05-2013. 

Tabla 11: Estructura de almacenamiento para la carta catastral 

CODIGO 
DEPARTAMENTO 

CODIGO 
MUNICIPIO 

ZONA SECTOR COMUNA BARRIO 
MANZANA 
O VEREDA 

7 3 0 0 1 0 1 1 0 0 0 0 0 0 3 2 5 

 

4.2.7. Carta Catastral Rural 

La Carta Catastral Rural se genera utilizando la plantilla CARTA_CATASTRAL_RURAL.mxd, la 
cual es suministrada de manera oficial por la Subdirección de Catastro. 

Tabla 12. Identificación del producto Carta Catastral Rural. 

ÁREA  PRODUCTO CARACTERÍSTICAS  ESCALA  FORMATO DE SALIDA 

Rural 

 
Carta 

Catastral 
 

Es la representación de los predios 
rurales sobre la carta de cartografía 
básica realizada por el IGAC, puede 
ser escala 1:10.000, 1:25.000 y 
1:50000, en casos especiales se 
cuenta con restituciones 1:5.000; sobre 
ésta se ha realizado la transferencia de 
los linderos prediales y codificación de 
los predios rurales en cada uno de los 
Municipios.  

 
 
 
 
 

1:5.000 
1:10.000 
1:25.000 
1:50.000 

OPCIÓN 1 

PDF 
300 Dpi 
tamaño de impresión 
105 X 63 cm horizontal 
(1:5.000y 1:10.000) 
 
OPCIÓN 2 

PDF 
300 Dpi 
tamaño de impresión 
88 x 55 cm horizontal 
(1:25.000y 1:50.000) 

° Caracterización de las cartas catastrales rurales 

- Formato Carta Catastral Rural: Mapas escala 1:5.000 y 1:10.000,  

Las medidas se dan en centímetros y las dimensiones de las cajas siempre indican ancho x alto. 
Los valores entre paréntesis expresan distancias en X y Y con respecto a la esquina inferior 

izquierda del papel [origen (0,0)] (Figura 53). 
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Figura 53. Formato Carta catastral Rural Escala 1:5.000 y 1:10.000. 

- Configuración de Etiquetas y símbolos para la salida gráfica.  
 

Tabla 13. Propiedades de Etiquetas y símbolos para el producto Carta catastral Rural Escala 1:5.000y 
1:10.000. 

CARTA CATASTRAL RURAL 

ESCALA COBERTURA 

ETIQUETA SÍMBOLO 

TAMAÑO FUENTE 
COLOR 
FUENTE 

RGB 
TIPO LÍNEA 

COLOR 
LÍNEA  
RGB 

5.000 
10.000 

ENTIDADES_TERRITORIALES_COLOMBIA 10 ARIAL NEGRILLA (0,0,0) SIN SIN SIN 

R_VEREDA 10 ARIAL NEGRILLA (0,0,0) 
LÍNEADISCONTINUA 

SEPARACIÓN 1 
1,5 (0,0,0) 

R_SECTOR 14 ARIAL (0,0,0) 
LÍNEADISCONTINUA 

SEPARACIÓN 1 
2 (230,0,0) 

R_TERRENO 9 ARIAL (52,52,52) LÍNEACONTINUA 1 (0,0,0) 

GRILLA10K 
GRILLA25K 

36 
ARIAL NEGRILLA 

INCLINADA 
(255,0,0) LÍNEACONTINUA 0,4 (255,0,0) 

DRENAJE_DOBLE 9 ARIAL (0,0,0) POLÍGONO 0,4 

RELLENO 
(151,219,242), 
CONTORNO 
(64,101,235) 

DRENAJE_SENCILLO 9 ARIAL CURSIVA (0,0,0) LÍNEA CONTINUA 1 (163,242,242) 

VIA_FERREA 8 ARIAL (0,0,0) LÍNEA CONTINUA 4 (0,0,0) 

CURVA DE NIVEL ÍNDICE 6 ARIAL (168,112,0) LÍNEA CONTINUA 0,71 (168,112,0) 

CURVA DE NIVEL INTERMEDIA 6 ARIAL (252,173,20) LÍNEA CONTINUA 0.35 (252,173,20) 
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*La leyenda y convenciones para la cartografía básica, son definidas por la representación establecida 
por la Subdirección de Geografía y Cartografía. 

° Formato Carta Catastral Rural: Mapas escala 1:25.000 y 1:50.000. 

Las medidas se dan en centímetros y las dimensiones de las cajas siempre indican ancho x alto. 
Los valores entre paréntesis expresan distancias en X y Y con respecto a la esquina inferior 
izquierda del papel [origen (0,0)], (Figura 54). 

 

Figura 54. Carta Catastral Rural Escala 1:25.000 y 1:50.000. 

- Las Etiquetas para la impresión deben ir configurados como se muestra en la Tabla 14, 
para la salida gráfica final. 
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Tabla 14. Propiedades de Etiquetas y símbolos para el producto Carta Catastral Rural 
Escala 1:25.000y 1:50.000 

CARTA CATASTRAL RURAL 

ESCALA COBERTURA 

ETIQUETA SÍMBOLO 

TAMAÑO FUENTE 
COLOR 
FUENTE 

RGB 
TIPO LÍNEA 

COLOR 
LÍNEA  
RGB 

25.000 
50.000 

ENTIDADES_TERRITORIALES_COLOMBIA 10 ARIAL NEGRILLA (0,0,0) SIN SIN SIN 

R_VEREDA 10 ARIAL NEGRILLA (0,0,0) 
LÍNEADISCONTINUA 

SEPARACIÓN 3 
1,5 (0,0,0) 

R_SECTOR 12 
ARIAL 

NEGRILLA 
(0,0,0) 

LÍNEADISCONTINUA 
SEPARACIÓN 3,5 

2 (230,0,0) 

R_TERRENO 6 ARIAL (0,0,0) LÍNEACONTINUA 0,2 (78,78,78) 

GRILLA25K 
GRILLA 25K 

36 
ARIAL NEGRILLA 

INCLINADA 
(255,0,0) LÍNEACONTINUA 0,4 (255,0,0) 

DRENAJE_DOBLE 9 ARIAL (0,0,0) POLÍGONO 0,4 

RELLENO 
(151,219,242), 
CONTORNO 
(64,101,235) 

DRENAJE_SENCILLO 9 ARIAL CURSIVA (0,0,0) LÍNEA CONTINUA 1 (163,242,242) 

VIA_FERREA 8 ARIAL (0,0,0) LÍNEA CONTINUA 4 (0,0,0) 

CURVA DE NIVEL ÍNDICE 6 ARIAL (168,112,0) LÍNEA CONTINUA 0,71 (168,112,0) 

CURVA DE NIVEL INTERMEDIA 6 ARIAL (252,173,20) LÍNEA CONTINUA 0.35 (252,173,20) 

*La leyenda y convenciones para la cartografía básica, son definidas por la representación establecida 
por la Subdirección de Geografía y Cartografía, los elementos de cartografía básica que aparecen en 
la anterior tabla son los mínimos que deben aparecer en el producto, sin embargo existe una gran 
cantidad de opciones para los elementos de cartografía básica según el modelo de datos vigente. 

- Aspectos a tener en cuenta antes de iniciar la elaboración del producto Carta Catastral Rural. 

La Carta Catastral Rural nos permite visualizar la distribución predial en un área definida junto con la 
cartografía base asociada, debido a esto el área a generar está definida por las planchas de las grillas 
del IGAC a escalas 1:10.000 y 1:25.000, de acuerdo a esto la identificación de la carta catastral rural 
será el código de la plancha. 

Es necesario también verificar la disponibilidad de información catastral del municipio, debido a que 
algunos son considerados como catastro fiscal, para ellos no es posible generar dicho producto, de 
igual forma se debe tener en cuenta que este producto se genera también en función al municipio 
solicitado, ya que en algunos casos se encontraran cartas catastrales rurales que contienen más de 
un municipio, siendo necesario generar tantas cartas catastrales rurales como municipios estén 
presentes en la misma. 

También se debe tener en cuenta, para la generación de la carta catastral rural el sistema de 
referencia de coordenadas del municipio, ya que la plantilla debe tener definido ese mismo, para que 
las coordenadas expresadas en el producto sean coherentes, así mismo es importante verificar la 
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disponibilidad de cartografía base asociada debido a que la podemos encontrar en formato TIFF o 
GDB, de estar disponible el formato TIFF esta debe estar debidamente georreferenciada.9 

° Generación de la Carta Catastral Rural 

a) El primer paso que debe realizar es seleccionar la plantilla oficial de la Carta catastral Rural de 
acuerdo a la escala solicitada, estás reposan en la siguiente ruta: 

Ftp DANE: /APOYOCENTRAL/plantillas_2017  Ó donde considere la ruta definida por la 
Territorial respectiva (Figura 55). 

 

 

Figura 55. Ruta de Ubicación de plantillas. 

b) Una vez seleccionada la plantilla a trabajar procedemos a cargarla información de los elementos 
contenidos en la carta catastral rural, este procedimiento se hace dando clic derecho en el feature 
a cargar ->Data->Repair Data Source. En este punto se selecciona la ubicación de cada 
elemento, no olvidar que si la cartografía base está en formato Tiff esta se debe encontrar 
Georreferenciada10 (Figura 56). 

                                                           
9 El Ítem de Georreferenciación puede ser consultado en el Instructivo Digitalización  v6, capítulo 5. Georreferenciación de planos 

de conjunto y cartas catastrales urbanas y rurales. 
10 Ibíd. 
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Figura 56. Cargue de Información. 

c) Una vez cargada la información, se verifica que sea igual el sistema de coordenadas de la 
plantilla y de la información geográfica catastral cargada, tomando como referencia la definida por 
la base catastral; para esto dar clic derecho sobre cualquier elemento de la base catastral-
>Properties->Source.(Figura 57). 

 

Figura 57. Verificación del sistema de referencia de la información catastral. 

d) Repetimos el mismo procedimiento para verificar el sistema de coordenadas del Frame, dando 
clic derecho sobre el Frame (RURAL) ->Properties->Coordinate System (Figura 58). 
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Figura 58. Verificación de sistema de referencia de Frame Rural. 

e) De encontrar diferencias, estando en la ventana de Properties, dar clic en la casilla de import y 
seleccionar el sistema de nuestra base de datos geográfica catastral. ->Properties-
>CoordinateSistem->Import-> seleccionar Sistema->Aceptar. 

f) Se deben verificar que los intervalos sean coherentes con la escala de generación, este valor 
debe ser el 10% de la escala de la plancha a generar, es decir, para la escala 1:10.000 debe ser 
cada 1.000m y para la escala 1:25.000 debe ser cada 2.500m, este procedimiento se realiza de 
la siguiente forma, clic derecho sobre el Frame (RURAL) ->Properties->Grids->Properties-
>Intervals (Figura 59). 

 

 

Figura 59. Verificación de los intervalos de la Grilla. 
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g) Ubicar la plancha a trabajar en el feature de la grilla IGAC, luego abrir la tabla de atributos del 
feature grilla y seleccionar la plancha deseada; posteriormente dar clic en el comando Zoom to 
selected, el cual ubicará la grilla correspondiente al área sobre la cual se generará la carta 
catastral rural (Figura 60). 

 

Figura 60. Selección de la plancha en la grilla IGAC. 

h) Defina la escala de generación en el Frame, este procedimiento se realiza para ajustar el área de 
la grilla al área del frame y así obtener la Carta Catastral Rural, dar clic derecho sobre el Frame 
(RURAL) ->Properties->DataFrame->Extent->Fixedscale-> Seleccionar la escala de generación-
>Aceptar (Figura 61). 

 

 

Figura 61. Definición de la escala del Frame. 

i) Como resultado se obtiene que el frame queda ajustado al área correspondiente de la grilla 
(Figura 62). 
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Figura 62. Frame ajustado a la grilla del IGAC. 

j) Organice el índice de hojas adyacentes, de tal forma que cubra las planchas seleccionadas del 
municipio (Figura 63). 

 

Figura 63. Índice de hojas adyacentes. 

k) Ajuste la información marginal, este procedimiento se encuentra descrito en la sección 4.1.4 de 
este documento, por favor consulte este ítem y aplicar a la plantilla trabajada. 

l) Exportar a PDF en las rutas de almacenamiento definidas, una vez realizado todo el 
procedimiento anteriormente descrito con las características definidas en la (Tabla 11)11 , 
nombrar el archivo como “CARTA_CATASTRAL_RURAL_XXXXX_indice de plancha” donde 
XXXXX corresponde al código del municipio y el índice de la plancha generada. 

4.2.8. Plano de Zonas Homogéneas Físicas Urbanas 

Las características básicas de los planos de Zonas Homogéneas Físicas (ZHF) y Zonas Homogéneas 
Geoeconómicas (ZHG) urbanos en cuanto a definición, escala y formato de impresión de la salida grafica 
se describen en la tabla 15. 
 
Las propiedades de etiquetas y simbología para este producto son básicamente las que se tienen en 
cuenta para la generación del plano de conjuntos urbano (ver tabla 4) más las correspondientes a las 
capas U_ZONA_HOMOGENEA_FISICA y U_ZONA_HOMOGENEA_GEOECONOMICA (Ver tabla 16). 
 

                                                           
11Ítem de Identificación del producto Carta Catastral Rural, Tabla 12. 
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Por otra parte, ya que la base cartográfica catastral es prácticamente la misma del plano de conjunto 
urbano así mismo los formatos vertical y horizontal de los planos de ZHF y ZHG urbanos presentan las 
mismas dimensiones (ver Figuras 1 y 2). 

 
Tabla 15. Caracterización del Plano de Zonas Homogéneas Físicas Urbanas. 

ZONA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Urbana  

Plano de Zonas 
Homogéneas 
Físicas 
Urbanas 

En este se encuentran representado: 
delimitación y codificación de los 
espacios geográficos con 
características similares de vías, 
servicios, usos del suelo, norma 
urbanística, topográfica para el área 
urbana, (Cabecera y Corregimientos) 
pertenecientes a cada municipio. Así 
mismo debe llevar la toponimia 
(quebradas, ríos, curvas de nivel, 
sitios de interés, entre otras).  

1:1.000 
A 

1:10.000 
 

Sólo 
múltiplos de 

1.000 

OPCIÓN 1 
PDF 
300 Dpi 
tamaño de impresión 
85 x 85 cm vertical 
 
OPCIÓN 2 
PDF 
300 Dpi 
tamaño de impresión 
90 x 90 cm horizontal 

 
 

Tabla 16. Propiedades de etiquetas y símbolos para los planos de Zonas Homogéneas Físicas Urbanas y 
Zonas Homogéneas Geoeconómicas Urbanas. 

PLANO DE ZONAS HOMOGÉNEAS FÍSICAS URBANAS 

ESCALA COBERTURA 

ETIQUETA SÍMBOLO 

Tama
ño 

Fuente 
Color 

Fuente 
RGB 

Tipo 
Tamaño 

Línea 
Color Línea 

RGB 
% 

Transparencia 

1.000 
A 

10.000 

U_ZONA_HOMOGE
NEA_FISICA 

9,00 
ARIAL 
Negrilla 

(0,0,0) Polígono 0,4 (0,0,0) 40 

U_ZONA_HOMOGE
NEA_GEOECONO

MICA 
9,00 

ARIAL 
Negrilla 

(0,0,0) Polígono 0,4 (0,0,0) 40 

 

4.2.8.1. Generación del Plano de Zonas Homogéneas Físicas Urbano 

 
El plano de ZHF urbano se elabora a solicitud del mismo, las escalas de generación deben permitir el 
fácil entendimiento de la información representada, esto teniendo en cuenta que el rango de escalas 
definido para este producto está entre 1:1.000 y 1:10.000 (múltiplos de 1.000).A continuación se 
describen los pasos a seguir para la generación del plano de ZHF urbano. 
 

I. Abrir la plantilla ZONAS_HOMOGENEAS_FISICAS_URBANAS.mxd 
 
Se encuentran dos opciones según el tamaño y la disposición de la cabecera municipal o 
perímetro urbano de los corregimientos y según la escala requerida (entre 1:1.000 y 1:10.000): 
 

 Vertical (ZONAS_HOMOGENEAS_FISICAS_URBANAS_V) 

 Horizontal (ZONAS_HOMOGENEAS_FISICAS_URBANAS_H) 
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Se recuerda que según la escala de generación se debe modificar la grilla de la salida gráfica, 
siendo el 10% de la escala representada. Si en la escala máxima de 1:10.000 en cualquiera de 
las dos plantillas no se abarca completamente la cabecera municipal o corregimiento, se debe 
generar los planos necesarios para representar la totalidad del perímetro urbano requerido. 
 

II. Para cargar las capas de la base cartográfica catastral, las entidades territoriales y el índice, así 
como para la edición de grillas se recomienda revisar el subcapítulo 4.2.1.1. Generación plano de 
conjunto urbano. Finalizado el cargue de la base cartográfica catastral el plano resultante es muy 
similar al plano de conjunto urbano del casco urbano en cuestión (ver Figura 64). 
 

III. Superposición del Feature Class U_ZONA_HOMOGENEA_FISICA 
 

De la misma manera como se direcciona el Data Source de las diferentes capas (ver subcapítulo 
4.2.1.1. Generación plano de conjunto urbano) también se carga la capa del plano de ZHF del 
casco urbano respectivo, haciendo clic en botón derecho sobre la capa 
U_ZONA_HOMOGENEA_FISICA ->Data->Repair Data Source y se busca la ruta dentro de la 
base de datos del Feature correspondiente. Es importante resaltar que la tabla de atributos de la 
capa de zonas debe estar completamente diligenciada ya que esto garantiza la óptima 
elaboración de la leyenda. 
 

IV. Asignación de colores 
 
Las zonas homogéneas físicas deben ser representadas con la paleta de colores “Dark Glazes” 
como se puede ver en la figura 65, la cual se puede visualizar dando clic derecho sobre la paleta 
> properties. Esta paleta se puede encontrar al igual que la rampa de colores del plano de ZHF 
en Layer Properties>Symbology dando clic derecho sobre la paleta >“savetostyle” (ver Figura 66). 
Se aconseja esta paleta ya que sus gamas de colores permiten la diferenciación clara entre 
zonas.  
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Figura 64. Plano de conjunto del casco urbano del municipio de Chía. 

 
Figura 65. Paleta de colores Dark Glazes. 
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Figura 66. Nombre de la paleta que se sugiere utilizar para la cobertura de ZHF Urbanas. 

 
Otras propiedades de los símbolos del Feature Class U_ZONA_HOMOGENEA_FISICA son 
definidas en la tabla 16, dentro de las cuales cabe resaltar que la forma del label de las capas de 
ZHF y ZHG urbanas y rurales se asigna en Layer Properties>Labels> Symbol > Block Number 
como lo muestra la figura 67.  
 

 
 

Figura 67. Asignación de símbolo al label de los features class de zonas homogéneas 
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En la figura 68 se observa el plano de ZHF urbano después de cargar y definir la paleta 
de colores de la capa U_ZONA_HOMOGENEA_FISICA. 
 

 

Figura 18. ZHF Urbanas de la cabecera municipal de Chía (Cundinamarca). 

 
V. Elaboración de la Leyenda 

 
La leyenda debe contener las variables involucradas en la definición de cada una de las zonas, 
para lo cual es necesario exportar la tabla de atributos del feature class 
U_ZONA_HOMOGENEA_FISICA en formato dBase Table (ver Figura 69).  
 
Una vez exportado el archivo se abre en EXCEL, se eliminan los campos que no sean necesarios 
y se colocan los rótulos del título, departamento, municipio, tipo de avaluó, tipo de proceso 
catastral y vigencia. Para incluir los colores correspondientes a cada zona en el campo de 
convenciones estos se deben extraer de la leyenda generada por ArcGIS, para lo cual se da clic 
en Insert>Leyend (ver Figura 70), en LegendItems se selecciona únicamente el MapLayers 
U_ZONA_HOMOGENEA_FISICA (ver Figura 71) y se da clic en siguiente hasta generar la 
leyenda. Para extraer cada una de las convenciones se hace clic derecho sobre la leyenda 
>Convert to Graphics, nuevamente clic derecho >Ungroup (ver Figura 72) y cortamos y pegamos 
las convenciones según el código de zona en el archivo EXCEL (ver Tabla 17). La leyenda 
finalmente elaborada se exporta a pdf y luego se toma una imagen instantánea de la misma con 
un zoom de 150%, se guarda como un archivo JPG o PNG en paint y en ArcGIS se importa como 
se muestra en la figura 73. La leyenda se ubica sobre el Data Frame de tal manera que no 
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obstruya la visibilidad de la información representada y en proporción con la orientación de la 
plantilla ver figura 74. 

 

 
 

Figura 69. Exportación de la tabla de atributos del Feature Class U_ZONA_HOMOGENEA_FISICA para 
generar la leyenda. 

 

 
Figura 70. Insertar leyenda generada por ArcGISLayoutview. 
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Figura 71. Selección de la capa del mapa que se quiere representar en la leyenda. 

 

 

Figura 72. Desagrupar los elementos de la leyenda. 
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Tabla 17. Leyenda del plano de ZHF Urbano del municipio de Chía (Las ZHF Urbanas de este municipio 
se numeran hasta 99 pero aquí solo se hace referencia a 30). 

 

VI. Exportar a PDF 
 
El plano se exporta a pdf con el nombre de 
“PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_URBANO_H_XXXXXXX” o 
“PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_URBANO_V_XXXXXXX” (según sea horizontal 
o vertical) donde XXXXXXX corresponde a: 

 
X X X X X X X 

Departamento Municipio Zona 

 
Adicionalmente cuando sea necesario generar más grillas por las dimensiones del municipio, el 
plano debe incluir n_de_N, donde n es el índice creado y N el total de grillas que abarcan al 
municipio. En la figura 75 se observa la salida grafica 

No. Área (m2) % Norma de Uso del Suelo Topografía Vías Servicios Uso Actual Tipificación Convención

01 24267 0,43 Área de Uso Múltiple Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Especializado

01.1 8370 0,15

Área Industrial Liviana de 

Medio a Bajo Impacto 

Ambiental

Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Especializado

02 4184 0,07 Área Residencial Urbana Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Especializado

03 23190 0,41
Zona de Protección del 

Sistema Hídrico
Plano Pavimentadas

Servicios básicos y 

complementarios
Comercial

Comercial 

Especializado

04 492775 8,65 Área de Uso Múltiple Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

05 123494 2,17 Área Residencial Urbana Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

06 22734 0,40
Área de Vivienda de 

Interés Social
Plano Pavimentadas

Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

07 84838 1,49 Área Histórica Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

07.1 32166 0,56 Área Histórica Plano Peatonales
Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

08 7110 0,12

Área Industrial Liviana de 

Medio a Bajo Impacto 

Ambiental

Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial

Comercial 

Sectorial

09 26661 0,47 Área Residencial Urbana Plano Pavimentadas
Servicios básicos y 

complementarios
Comercial Comercial Barrial

20 1231 0,02 Área de Uso Múltiple Plano Pavimentadas
Servicios básicos y 

complementarios
Residencial

Residencia 2-

(Bajo)

21 3738 0,07 Área Residencial Urbana Plano Pavimentadas
Servicios básicos y 

complementarios
Residencial

Residencia 2-

(Bajo)

22 4810 0,08 Área Residencial Urbana Plano Pavimentadas
Servicios básicos y 

complementarios
Residencial

Residencia 2-

(Bajo)

23 48072 0,84
Área de Vivienda de 

Interés Social
Plano Pavimentadas

Servicios básicos 

completos
Residencial

Residencia 2-

(Bajo)

24 38414 0,67
Área de Vivienda de 

Interés Social
Plano Sin pavimentar

Servicios básicos 

completos
Residencial

Residencia 2-

(Bajo)

25 3688 0,06
Área de Vivienda de 

Interés Social
Plano Peatonales

Servicios básicos 

completos
Residencial

Residencia 2-

(Bajo)

26 3881 0,07
Zona de Protección del 

Sistema Hídrico
Plano Pavimentadas

Servicios básicos 

completos
Residencial

Residencia 2-

(Bajo)

30 264552 4,64 Área de Uso Múltiple Plano Pavimentadas
Servicios básicos y 

complementarios
Residencial

Residencial 3-

(Medio-Bajo)
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PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_URBANO_H_2517501 correspondiente al 
municipio de Chía – Cundinamarca. 
 

 

Figura 73. Como insertar la leyenda generada en EXCEL. 

 

 

Figura 74. Plano de ZHF Urbano con su leyenda respectiva en Layout View. 
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4.2.9. Plano de Zonas Homogéneas Geoeconómicas Urbanas 

Las pautas de elaboración de este plano son similares a las del plano de ZHF urbano, difiriendo 
únicamente en la paleta de colores que representan a las zonas y los campos que conforman la 
leyenda. 
 
En la tabla 18 se describen las características básicas en cuanto a la escala y el formato de 
impresión de la salida grafica “Plano de ZHG Urbano”. Las características de las etiquetas y 
símbolos de este producto son equivalentes a las utilizadas en el plano de ZHF Urbano (ver 
Tabla 16). 

 

 

Figura 75. PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_URBANO_H_2517501. 

 

4.2.9.1. Generación del Plano de Zonas Homogéneas Geoeconómicas Urbano 

 
El plano de Zonas Homogéneas Geoeconómicas Urbano se elabora a solicitud del mismo, las escalas de 
generación deben permitir el fácil entendimiento de la información representada, esto teniendo en cuenta 
que el rango de escalas definido para este producto está entre 1:1.000 y 1:10.000 (múltiplos de 1.000). A 
continuación se describen los pasos a seguir para la generación del plano de ZHG Urbano. 
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I. Abrir la plantilla ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANAS 
 
Se encuentran dos opciones según el tamaño y la disposición de la cabecera municipal o 
perímetro urbano de los corregimientos y según la escala requerida (entre 1:1.000 y 1:10.000): 
 

 Vertical (ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANAS_V) 

 Horizontal (ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANAS_H) 
 
Se recuerda que según la escala de generación se debe modificar la grilla de la salida gráfica, 
siendo el 10% de la escala representada. Si en la escala máxima de 1:10.000 en cualquiera de 
las dos plantillas no se abarca completamente la cabecera municipal o corregimiento, se debe 
generar los planos necesarios para representar la totalidad del perímetro urbano requerido. 
 

II. Para cargar las capas de la base cartográfica catastral, las entidades territoriales y el índice, así 
como la edición de grillas se recomienda revisar el subcapítulo 4.2.1.1. Generación plano de 
conjunto urbano. Finalizado el cargue de la base cartográfica catastral el plano resultante es 
prácticamente el plano de conjunto urbano del casco urbano en cuestión (ver Figura 64). 
 

III. Superposición del Feature Class U_ZONA_HOMOGENEA_GEOECONOMICA 
 

De la misma manera como se direcciona el Data Source de las diferentes capas (ver subcapítulo 
4.2.1.1. Generación plano de conjunto urbano) también se carga la capa del plano de ZHG 
urbano del casco urbano respectivo, haciendo clic en botón derecho sobre la capa 
U_ZONA_HOMOGENEA_GEOECONOMICA->Data->Repair Data Source y se busca la ruta 
dentro de la base de datos del Feature correspondiente. Es importante resaltar que la tabla de 
atributos de la capa de zonas debe estar completamente diligenciada ya que esto garantiza la 
óptima elaboración de la leyenda. 
 

IV. Asignación de colores 
 
Las zonas homogéneas geoeconómicas deben representarse con la paleta de colores “Basic 
Random” como se puede ver en la figura 76, la cual se puede visualizar dando clic derecho sobre 
la paleta>properties. Esta paleta se puede encontrar al igual que la rampa de colores del plano 
de ZHF en Layer Properties>Symbology dando clic derecho sobre la paleta >“savetostyle” (ver 
Figura 66).  
 
En la tabla 4 se describen las propiedades de símbolos y etiquetas para el feature class 
U_ZONA_HOMOGENEA_FISICA las cuales también aplican para el feature 
U_ZONA_HOMOGENEA_GEOECONOMICA. Dentro de esas propiedades cabe resaltar que la 
forma del label tanto de la capa de ZHF (Codigo_Zona_Fisica) como la capa de ZHG 
(Codigo_Zona_Geoeconomica) se asigna en LayerProperties>Labels> Symbol > Block Number 
(ver figura 67). 

 
En la figura 77 se observa el plano de ZHG Urbano después de cargar y definir la paleta de 
colores del Feature Class U_ZONA_HOMOGENEA_GEOECONOMICA. 
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Tabla 18. Caracterización del Plano de Zonas Homogéneas Físicas Urbanas. 

ZONA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Urbana  

Plano de Zonas 
Homogéneas 
Geoeconómicas 
Urbanas 

En este se encuentran representado: 
delimitación y codificación de los 
espacios geográficos con 
características similares en cuanto a 
destinación económica y valor del 
terreno y la construcción. 
Delimitación y codificación de las 
Sub-zonas Geoeconómicas Urbanas 
correspondientes a la Cabecera y 
Corregimientos pertenecientes a 
cada municipio. 

1:1.000 
A 

1:10.000 
 

Sólo 
múltiplos de 

1.000 

OPCIÓN 1 
PDF 

300 Dpi 
tamaño de 
impresión 

85 x 85 cm vertical 
 

OPCIÓN 2 
PDF 

300 Dpi 
tamaño de 

impresión 90 x 90 
cm horizontal 

 

 

Figura 76.Paleta de colores Basic Random. 

 
V. Elaboración de la Leyenda 

 
La leyenda debe contener las variables involucradas en la definición de cada una de las zonas, 
para lo cual es necesario exportar la tabla de atributos del feature class 
U_ZONA_HOMOGENEA_GEOECONOMICA en formato dBaseTable así como se hace con la 
tabla de atributos del feature class de la capa de ZHF Urbana (ver Figura 69). Una vez exportado 
el archivo se abre en EXCEL, se eliminan los campos que no sean necesarios y se colocan los 
rótulos del título, departamento, municipio, tipo de avaluó, tipo de proceso catastral y vigencia. 
Para incluir los colores correspondientes a cada zona en el campo de convenciones estos se 
deben extraer de la leyenda generada por ArcGIS, para lo cual se da clic en Insert>Leyend (ver 
Figura 70), en LegendItems se selecciona únicamente el MapLayers 
U_ZONA_HOMOGENEA_GEOECONOMICA como se muestra en la figura 71 pero aplicado al 
caso de la capa de ZHG. Para extraer cada una de las convenciones se hace clic derecho sobre 
la leyenda >Convert to Graphics, nuevamente clic derecho >Ungroup (ver Figura 78) y se cortan 
y pegan las convenciones según el código de zona en el archivo EXCEL (ver Tabla 19). La 
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leyenda finalmente elaborada se exporta a pdf y luego se toma una imagen instantánea de la 
misma con un zoom de 150%, se guarda como un archivo JPG o PNG en paint y en ArcGIS se 
importa como se muestra en la figura 73. La leyenda se ubica sobre el Data Frame de tal manera 
que no obstruya la visibilidad de la información representada y en proporción con la orientación 
de la plantilla ver figura 79. 
 

VI. Exportar a PDF 
 
El plano se exporta a pdf con el nombre de 
“PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANO_H_XXXXXXX” o 
“PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANO_V_XXXXXXX” (según 
sea horizontal o vertical) donde XXXXXXX corresponde a: 
 

X X X X X X X 

Departamento Municipio Zona 

 
Adicionalmente cuando sea necesario generar más grillas por las dimensiones del municipio, el 
plano debe incluir n_de_N, donde n es el índice creado y N el total de grillas que abarcan al 
municipio. En la figura 80 se observa la salida grafica 
PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANO_2517501 
correspondiente al municipio de Chía – Cundinamarca. 
 

 
Figura 77. Capa de ZHG Urbanas de la cabecera municipal de Chía (Cundinamarca). 
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Figura 78. Desagrupar los elementos de la leyenda. 
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Tabla 19. Leyenda del plano de ZHG Urbano del municipio de Chía. 

 

 

4.2.10. Plano de Zonas Homogéneas Físicas Rurales 

 
Las características básicas de los planos de ZHF y ZHG rurales en cuanto a escala y formato de 
impresión de la salida grafica se describen en la tabla 20. 
 

ZONA ZONA FÍSICA Área (m2) % Valor/m2 Convención

01 01-31-42-51 27184 0,5 2000000

02 04-42-51 71916 1,3 1200000

03 04-05-06-42-51-81 336936 5,9 1010000

04 42-31-51 9129 0,2 950000

05 1.1-04-40-42-43-51-91 159310 2,8 900000

06 30-04-05-33-40-42-45 246676 4,3 860000

07
01-07-08-09-30-31-32-33-31.1-40-

42-43-51-52-53
261019 4,6 810000

08
04-09-30-30.1-31-31.1-40-41-42-50-

51-52
267864 4,7 760000

09 04-30-30.1-31-31.1-40-41-42-50-51 322293 5,7 715000

10
04-07-30-31-31.1-42-44-46-50-51-

80-81-93
643864 11,3 650000

11
02-30-31-31.1-40-42-46-50-51-71-

80-81-82-90-091.1-92-92.1-93
1485229 26,1 610000

12
40-21-30-30.1-31-31.1-31.2-35-40-

42-50-51-81
143744 2,5 560000

13
20-23-30-30.1-30.2-31-31.1-32-40-

42-47-51-80-81-84-90-91-91.3
327884 5,8 500000

14
22-23-24-31.2-37-37.1-40-42-51-52-

71-80-81-92-95
384468 6,7 450000

15
05-24-38-42-46-48-50-51-52-53-70-

72-80-81-91.2-91.3-93.1
377384 6,6 410000

16 25-34-37.2-39-51-82-83-91.1-92 154397 2,7 360000

17 23-36-39-51-52-81-82-85-86-87-91 181316 3,2 300000

18 42-51-52 71377 1,3 250000

19 50-51 14326 0,3 200000

20 94 49898 0,9 150000

21 26-96-96.1-97-98 32555 0,6 70000

22 03-72-99 127424 2,2 30000

23 72 2905 0,1 10000
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Las propiedades de etiquetas y simbología para este producto son básicamente las que se tienen 

en cuenta para la generación de la carta catastral rural (ver tablas 13 y 14) más las 
correspondientes a las capas R_ZONA_HOMOGENEA_FISICA y 
R_ZONA_HOMOGENEA_GEOECONOMICA (Ver tabla 21). 
 
Por otra parte, ya que la base cartográfica catastral es básicamente la misma de la carta catastral 
rural de igual manera se comparten las mismas dimensiones de los formatos según la escala de 
generación (ver Figuras 53 y 54)  
 

 

Figura 79. Plano de ZHG Urbano con su leyenda respectiva en Layout View. 

 
Tabla 20. Caracterización del Plano de Zonas Homogéneas Físicas Rurales. 

ZONA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Rural 
Plano de Zonas 
Homogéneas 

Físicas Rurales 

Son los planos en los cuales se 
representan la delimitación y 
codificación del espacio geográfico 
rural con características similares en 
cuanto a áreas homogéneas de 
tierra, disponibilidad de agua, 
influencia vial, norma de uso del 
suelo y uso actual del suelo. El plano 
también incluye tanto la cartográfica 
base como la predial. 

1:25.000 
1:50.000 

OPCIÓN 1 PDF 300 
Dpi tamaño de 
impresión 105 X 63 
cm horizontal 
(1:5.000 y 
1:10.000). 
 
OPCIÓN 2 PDF 300 
Dpi tamaño de 
impresión 88 x 55 
cm horizontal 
(1:25.000 y 
1:50.000) 
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Figura 80. PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_URBANO_2517501. 

 
Tabla 21. Propiedades de Etiquetas y Símbolos para las capas R_ZONA_HOMOGENEA_FISICA y 

R_ZONA_HOMOGENEA_GEOECONOMICA. 

PLANOS DE ZONAS HOMOGÉNEAS FÍSICAS Y GEOECONOMICAS RURAL 

ESCAL
A 

COBERTURA 

ETIQUETA SÍMBOLO 

Tamañ
o 

Fuent
e 

Color 
Fuente 
RGB 

Tipo 
Tamañ
o Línea 

Color Línea 
RGB 

% 
Trans
paren

cia 
5.000  

A 
10.000 y 
25.000  

A 
50.000 

R_ZONA_HOMO
GENEA_FISICA 

9,00 
ARIAL 
Negrilla 

(0,0,0) Polígono 0,4 (0,0,0) 40 

R_ZONA_HOMO
GENEA_GEOEC

ONOMICA 
9,00 

ARIAL 
Negrilla 

(0,0,0) Polígono 0,4 (0,0,0) 40 
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4.2.10.1. Generación del Plano de Zonas Homogéneas Físicas Rural 

 
El plano de Zonas Homogéneas Físicas Rural se elabora a solicitud del mismo, las escalas de 
generación deben permitir el fácil entendimiento de la información representada teniendo en cuenta que 
el rango está entre 1:25000 – 1:50000. A continuación se describen los pasos a seguir para la generación 
del plano de ZHF Rural: 

 
I. Abrir la plantilla ZONAS_HOMOGENEAS_FISICAS_RURALES 

 
Se abre la plantilla ZONAS_HOMOGENEAS_FISICAS_RURALES y según la escala requerida y 
la disponibilidad de la cartografía base se genera el plano a escala 25.000 o 50.000. 
 
Se recuerda que según la escala de generación se debe modificar la grilla de la salida gráfica, 
siendo el 10% de la escala representada. Por otra parteen caso de que el área rural del municipio 
solicitado no sea incluida en su totalidad por un solo índice de hoja será oportuno generar el 
número de planos que sean necesarios. 
 

II. Para cargar las capas de la base cartográfica catastral, las entidades territoriales y el índice se 
recomienda revisar el subcapítulo 4.2.7. Carta Catastral Rural, así como para el proceso de 
edición de grillas. Finalizado el cargue de la cartografía básica el plano resultante es 
prácticamente la carta catastral rural del municipio en cuestión (ver Figura 81). 
 

III. Superposición del Feature Class R_ZONA_HOMOGENEA_FISICA 
 

De la misma manera como se direcciona el Data Source de las diferentes capas (ver subcapítulo 
4.2.7. Carta Catastral Rural) también se carga la capa del plano de ZHF rural del municipio 
respectivo, haciendo clic en el botón derecho sobre la capa R_ZONA_HOMOGENEA_FISICA -
>Data->Repair Data Source y se busca la ruta dentro de la base de datos del Feature 
correspondiente. Es importante resaltar que la tabla de atributos de la capa de zonas debe estar 
completamente diligenciada ya que esto garantiza la óptima elaboración de la leyenda. 
 

IV. Asignación de colores 
 
Las zonas homogéneas físicas rurales deberán ser representadas con la misma paleta de colores 
utilizada para el plano de ZHF Urbano definida como “Dark Glazes” (ver figuras 65 y 66). Se 
aconseja esta paleta ya que sus gamas de colores permiten la diferenciación clara entre zonas.  
 
Otras propiedades de los símbolos del Feature Class R_ZONA_HOMOGENEA_FISICA están 
definidas en la tabla 21, dentro de la cual cabe resaltar que la forma del label de las capas de 
ZHF y ZHG urbanas y rurales se asigna en Layer Properties>Labels> Symbol > Block Number 
como lo muestra la figura 67. 
 
En la figura 82 se observa el plano de ZHF Rural después de cargar y definir la paleta de colores 
de la capa R_ZONA_HOMOGENEA_FISICA. 
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Figura 81. CARTA_CATASTRAL_RURAL_25001_245IVB correspondiente al municipio de Agua de Dios 

escala 1:25.000. 

 
V. Elaboración de la Leyenda 

 
La leyenda debe contener las variables involucradas en la definición de cada una de las zonas, 
para lo cual es necesario exportar la tabla de atributos del feature class 
R_ZONA_HOMOGENEA_FISICA en formato dBase Table (ver Figura 69). Una vez exportado el 
archivo se abre en EXCEL, se eliminan los campos que no sean necesarios y se colocan los 
rótulos del título, departamento, municipio, tipo de avaluó, tipo de proceso catastral y vigencia. 
Para incluir los colores correspondientes a cada zona en el campo de convenciones estos se 
deben extraer de la leyenda generada por ArcGIS, para lo cual se da clic en Insert>Leyend (ver 
Figura 70), en Legend Ítems se selecciona únicamente el MapLayers 
R_ZONA_HOMOGENEA_FISICA como se muestra en la figura 71 pero aplicado al caso de la 
capa de ZHF Rural y se da siguiente hasta generar la leyenda. Para extraer cada una de las 
convenciones se hace clic derecho sobre la leyenda >ConverttoGraphics, nuevamente clic 
derecho >Ungroup (ver Figura 72) y cortamos y pegamos las convenciones según el código de 
zona en el archivo EXCEL (ver Tabla 22). 
La leyenda finalmente elaborada se exporta a pdf y luego se toma una imagen instantánea de la 
misma con un zoom de 150%, se guarda como un archivo JPG o PNG en paint y en ArcGIS se 
importa como se muestra en la figura 73 y se ubica debajo de las convenciones (ver figura 83). 
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Figura 82. Capa de ZHF Rural escala 1:25.000 la cual abarca gran parte del municipio de Agua de Dios - 
Cundinamarca. 

 
VI. Exportar a PDF 

 
El plano se exporta a pdf con el nombre 
“PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_RURAL_XXXXX_indice de plancha” donde 
XXXXX corresponde al código del municipio. 
 
En la figura 84 se observa la salida grafica 
PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_RURAL_25001_245IVB (escala 1:25.000) la 
cual abarca casi en su totalidad el municipio de Agua de Dios – Cundinamarca. 

 

4.2.11.  Plano de Zonas Homogéneas Geoeconómicas Rural 

 
Las pautas de elaboración para este plano son similares a las del plano de ZHF Rural, difiriendo 
únicamente en la paleta de colores que representan a las zonas y los campos que conforman la 
leyenda. En la tabla 23 se describen las características básicas en cuanto a la escala y el formato 
de impresión de la salida grafica “Plano de ZHG Rural”. 
 
Así mismo en la tabla 21 se describen las propiedades de los símbolos y etiquetas para la capa 
R_ZONA_HOMOGENEA_GEOECONOMICA. 
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Tabla 22. Leyenda del plano de ZHF Rural del municipio de Agua de Dios. 

 

Nota 1: Para el ejemplo aquí citado correspondiente a la hoja de índice 245IVB la capa de ZHF 
Rural presenta su tabla de atributos incompleta lo que conlleva a que la leyenda también quede 
en ese estado. Por consiguiente se hace énfasis en que la tabla de atributos de los feature class 
de cualquiera de los cuatros planos de zonas homogéneas deben estar completamente 
diligenciadas y por lo tanto sus leyendas completas.  

 

 

Figura 83. Plano de ZHF Rural con su leyenda respectiva en Layout View. 
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Figura 84. PLANO_DE_ZONAS_HOMOGENEAS_FISICAS_RURAL_25001_245IVB. 

 
Tabla 13. Características del Plano de Zonas Homogéneas Geoeconómicas Rural. 

ZONA PRODUCTO CARACTERÍSTICAS ESCALA FORMATO 

Rural 

Plano de Zonas 
Homogéneas 

Geoeconómicas 
Rurales 

Son los mapas en los cuales se 
representa la delimitación y 
codificación del espacio geográfico de 
una región con características 
similares en cuanto a su precio, para 
el área rural de cada uno de los 
municipios. 

1:25.000 
1:50.000 

OPCIÓN 1 PDF 300 
Dpi tamaño de 
impresión 105 X 63 
cm horizontal 
(1:5.000 y 1:10.000). 
 
OPCIÓN 2 PDF 300 
Dpi tamaño de 
impresión 88 x 55 cm 
horizontal (1:25.000 y 
1:50.000) 

 

4.2.11.1. Generación del Plano de Zonas Homogéneas Geoeconómicas Rural 

 
El plano de Zonas Homogéneas Geoeconómicas Rural se elabora a solicitud del mismo, las escalas de 
generación deben permitir el fácil entendimiento de la información representada, esto teniendo en cuenta 
que el rango de escalas definido para este producto se encuentra entre 1:25000 – 1:50000. A 
continuación se describen los pasos a seguir para la generación del plano de ZHG Rural. 
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I. Abrir la plantilla ZONAS_HOMOGENEAS_GEOECONOMICAS_RURALES 
 
Se abre la plantilla ZONAS_HOMOGENEAS_GEOECONOMICAS_RURALES y según la escala 
requerida y la disponibilidad de la cartografía base se genera el plano a escala 25.000 o 50.000. 
 
Se recuerda que según la escala de generación se debe modificar la grilla de la salida gráfica, 
siendo el 10% de la escala representada. Por otra parte, en caso de que el área rural del 
municipio solicitado no sea incluida en su totalidad por un solo índice de hoja será oportuno 
generar el número de planos que sean necesarios. 
 

II. Para cargar las capas de la base cartográfica catastral, las entidades territoriales y el índice se 
recomienda revisar el subcapítulo 4.2.7. Carta Catastral Rural, así como para el proceso de 
edición de grillas. Finalizado el cargue de la base cartográfica catastral el plano resultante es 
prácticamente la carta catastral rural del municipio en cuestión (ver Figura 81). 
 

III. Superposición del Feature Class R_ZONA_HOMOGENEA_GEOECONOMICA 
 

De la misma manera como se direcciona el Data Source de las diferentes capas (ver subcapítulo 
4.2.7. Carta Catastral Rural) también se carga la capa del plano de ZHG rural del municipio 
respectivo, haciendo clic en el botón derecho sobre la capa 
R_ZONA_HOMOGENEA_GEOECONOMICA ->Data->RepairDataSource y se busca la ruta 
dentro de la base de datos del Feature correspondiente. Es importante resaltar que la tabla de 
atributos de la capa de zonas debe estar completamente diligenciada ya que esto garantiza la 
óptima elaboración de la leyenda. 
 

IV. Asignación de colores 
 
Las zonas homogéneas geoeconómicas rurales deberán ser representadas con la misma paleta 
de colores utilizada para el plano de ZHG Urbano definida como “Basic Random” (ver figura 76). 
Se aconseja esta paleta ya que sus gamas de colores permiten la diferenciación clara entre 
zonas.  
 
Otras propiedades de los símbolos del Feature Class 
R_ZONA_HOMOGENEA_GEOECONOMICA están definidas en la tabla 21, dentro de la cual 
cabe resaltar que la forma del label de las capas de ZHF y ZHG urbanas y rurales se asigna en 
LayerProperties>Labels> Symbol > Block Number como lo muestra la figura 67.  
 
En la figura 85 se observa el plano de ZHG Rural después de cargar y definir la paleta de colores 
de la capa R_ZONA_HOMOGENEA_GEOECONOMICA. 
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Figura 85. Capa de ZHG Rural escala 1:25.000 la cual abarca gran parte del municipio de Agua de Dios - 

Cundinamarca. 

 
V. Elaboración de la Leyenda 

 
La leyenda debe contener las variables involucradas en la definición de cada una de las zonas, 
para lo cual es necesario exportar la tabla de atributos del feature class 
R_ZONA_HOMOGENEA_GEOECONOMICA en formato dBaseTable (ver Figura 69). Una vez 
exportado el archivo se abre en EXCEL, se eliminan los campos que no sean necesarios y se 
colocan los rótulos del título, departamento, municipio, tipo de avaluó, tipo de proceso catastral y 
vigencia. Para incluir los colores correspondientes a cada zona en el campo de convenciones 
estos se deben extraer de la leyenda generada por ArcGIS, para lo cual se da clic en 
Insert>Leyend (ver Figura 70), en LegendItems se selecciona únicamente el MapLayers 
R_ZONA_HOMOGENEA_GEOECONOMICA como se muestra en la figura 71 pero aplicado al 
caso de la capa de ZHG Rural y se da siguiente hasta generar la leyenda. Para extraer cada una 
de las convenciones se hace clic derecho sobre la leyenda >ConverttoGraphics, nuevamente clic 
derecho >Ungroup (ver Figura 78) y cortamos y pegamos las convenciones según el código de 
zona en el archivo EXCEL (ver Tabla 24). 
 
La leyenda finalmente elaborada se exporta a pdf y luego se toma una imagen instantánea de la 
misma con un zoom de 150%, se guarda como un archivo JPG o PNG en paint y en ArcGIS se 
importa como se muestra en la figura 86. 
 



    
INSTRUCTIVO 

GENERACIÓN DE SALIDAS GRÁFICAS DE LOS PRODUCTOS 
CATASTRALES  

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 66 de 73 

Cód. I51600-02/17.V1 

Fecha Mayo de 2017 

 

 COPIA NO CONTROLADA 

 
 

Tabla 24. Leyenda del plano de ZHG Rural del municipio de Agua de Dios. 

 
 

VI. Exportar a PDF 
 
El plano se exporta a pdf con el nombre 
“PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_RURAL_XXXXX_indice de 
plancha” donde XXXXX corresponde al código del municipio. 
 
En la figura 87 se observa la salida grafica 
PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_RURAL_25001_245IVB (escala 
1:25.000) la cual abarca casi en su totalidad el municipio de Agua de Dios – Cundinamarca. 

 

 
Figura 86. Plano de ZHG Rural con su leyenda respectiva en Layout View. 
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Figura 87. PLANO_DE_ZONAS_HOMOGENEAS_GEOECONOMICAS_RURAL_25001_245IVB. 

 

4.3. ESTÁNDARES PARA LA GENERACIÓN DEL PRODUCTO 

4.3.1. SALIDAS GRÁFICAS 

Para generar las salidas graficas de todos los productos catastrales urbanos y rurales se realizan 
los siguientes pasos de forma general.  

4.3.2. Cargue de las plantillas MXD 

1. Abrirla plantilla del tipo de producto que desee crear, una vez tenga las plantillas mxd en su 
espacio de trabajo. Recuerde que el archivo no tiene el sistema de coordenadas por lo que es 
necesario verificarlas. 

2. Configuración del Tamaño del Papel: configure el tamaño del papel una vez abierto el MXD 
del producto que desea generar. En la pestaña FILE, busque la función PRINT AND PAGE 
SETUP, seleccione el plotter que tenga configurado para este caso EPSON STYLUS PRO 
9700, busque la opción PROPERTIES, luego la opción USER DEFINED y configure la opción 
del papel y la orientación (Figura 88). 



    
INSTRUCTIVO 

GENERACIÓN DE SALIDAS GRÁFICAS DE LOS PRODUCTOS 
CATASTRALES  

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 68 de 73 

Cód. I51600-02/17.V1 

Fecha Mayo de 2017 

 

 COPIA NO CONTROLADA 

 
 

 

Figura 88. Configuración de tamaño de papel de la salida gráfica del producto. 

4.3.3. Cargue de la información 

1. Direccionarlos Features del municipio al cual se le generarán las salidas gráficas con la 
opción Repair Data Source. Se busca cualquiera de los niveles de información a trabajar 
(Figura 89). 

 

Figura 89. Ubicación de la ruta de las coberturas requeridas para los productos a generar. 
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2. Utilice la opción Zoom to Layer sobre alguna capa, para visualizar las coberturas sobre el 
Layout (Figura 90). 

 

Figura 90. Acercamiento a la capa seleccionada. 

4.3.4. Niveles de información 

I. Verifique uno a uno que los niveles de información hayan sido cargados correctamente y que 
contengan todos los datos, para garantizar la completitud de la información a generar (Figura 
91). 

 

Figura 91. Verificación del contenido de los datos dentro de cada nivel de información. 
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4.3.5. Información marginal. (Figura 92). 

 

Figura 92. Ítems a modificar en la información marginal de la salida grafica 

 

1. Convenciones: revisar la coherencia de las convenciones. 

2. Información de referencia: revisar que correspondan los datos del Sistema de Referencia, 
Elipsoide, Proyección Cartográfica, Coordenadas geográficas, Falso Origen, Origen, Fuente, 
Escala de Captura, Fecha de generación, El formato disponible. 

3. Cambie la información marginal en el Layout, correspondiente a Territorial, Departamento, 
Municipio, la fecha de la vigencia, escala de acuerdo al municipio y el nombre del plano 
(Figura 92). 

4. En el caso que se necesite la localización del municipio dentro del departamento, se debe 
cargar la cobertura de los municipios (ENTIDADES TERRITORIALES COLOMBIA) y hacer 
una búsqueda del departamento así: en la pestaña de Definition Query dar clic en Query 
Builder [DEPARTAMEN] = 'CUNDINAMARCA' luego en symbology se añade por medio de 
Add values el nombre del municipio y le damos el color rojo (255, 0,0) (Figura 93). 
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Figura 93. Selección del municipio a cargar en la información marginal-localización. 

4.3.6. Configuración de la grilla 

I. Edite el Data Frame sobre la carta catastral una vez verificada la información, de tal forma que 
la grilla aparezca completa y cubra toda la información digital. 

II. Primero clic sobre view y después sobre data frame properties, coloque Fixed Scale en Data 
Frame a la escala que permita visualizar la completitud de la información, (Figura 94). 
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Figura 94. Menú para dejar la escala fija. 

III. Clic sobre la pestaña GRIDS, posteriormente en ->PROPERTIES. Edite los intervalos en X y 
Y que permitan visualizar las grillas sin que se corten e igualmente coloque en ORIGIN 
intervals X: 1’000.000 y en Y: 1’000.000. Luego manualmente mueva el DATA FRAME, para 
colocar la grilla cerrada (Figura 95). 

 

Figura 95. Ubicación de la grilla en un valor cerrado 

IV. Intervalos recomendados para las divisiones de la grilla: 

Tabla 25. Divisiones de grilla. 

PRODUCTO 
INTERVALO DE 
COORDENADAS 

Planchas Escala 1:25.000 2.500 m 

Planchas Escala 1:10.000 1.000 m 

Planchas Escala 1:2.000 200 m 

 



    
INSTRUCTIVO 

GENERACIÓN DE SALIDAS GRÁFICAS DE LOS PRODUCTOS 
CATASTRALES  

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 73 de 73 

Cód. I51600-02/17.V1 

Fecha Mayo de 2017 

 

 COPIA NO CONTROLADA 

 
 

5. ANEXOS 

° Anexo 1. Edición de etiquetas en la Carta Catastral. 

6. IDENTIFICACIÓN DE CAMBIOS  

VERSIÓN CAPÍTULO DESCRIPCIÓN FECHA 

1 

Encabezado 

Se cambia el nombre del GIT Gestión de Información Catastral Digital por 
GIT de Conservación Catastral y se ajusta el código I51300-01/12 por 
I51600-02/17.V1, de acuerdo con la estructura vigente de la Subdirección 
de Catastro.  Mayo 

de 
2017 

3 Se ajustan características de salidas gráficas 

4 
Se ajusta proceso para salidas gráficas 

Se incluyen las salidas gráficas para los planos de zonas homogéneas 

5 Se crea el anexo edición de etiquetas en la Carta Catastral 
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EDICIÓN DE ETIQUETAS EN LA CARTA CATASTRAL 

En ocasiones cuando se generan las cartas catastrales |las etiquetas de la nomenclatura domiciliaria 
no son legibles, como lo ilustra la (Figura 96). 

 

Figura 96. Nomenclatura domiciliaria ilegible. 

Para solucionar este problema se incluyó el botón Etiqueta to Annotation  que crea una capa de 
anotaciones a partir de las etiquetas de la nomenclatura domiciliaria. A continuación se describe el 
proceso para el correcto funcionamiento de este botón, que es empleado cuando se generan cartas 
catastrales en forma individual: 

 

A1. INSTALACIÓN DEL BOTÓN  

El archivo consta de un archivo ejecutable (Figura 97), sobre el cual se da un doble clic: 

 

Figura 97. Herramienta que crea una capa de anotación. 

 

Después aparece una ventana en la cual se da clic en,                                         con lo cual se 
instala el botón. 

 



    

ANEXO 1 

EDICIÓN DE ETIQUETAS EN LA CARTA CATASTRAL 

GRUPO INTERNO DE TRABAJO DE CONSERVACIÓN CATASTRAL 

Pág. 2 de 9 

Fecha Mayo de 2017 

 

 
 

Si la instalación fue exitosa, aparecerá el siguiente mensaje (Figura 98). 

 

Figura 98. Mensaje de instalación exitosa. 

A2. ACTIVACIÓN DEL BOTÓN 

En ArcMap se abre la pestaña Customize del menú principal, después Customize Mode (Figura 99). 

 

Figura 99. Personalización de la herramienta para crear una capa de anotación. 

En la ventana Customize, se selecciona la pestaña Commands. En Categories se selecciona Add-In 
Controls y en Commands se selecciona Etiqueta to Annotations. Haciendo uso del puntero se 
arrastra el icono                           Hasta la posición en la barra de herramientas deseada en el 
entorno ArcMap.  

Finalmente se realiza clic en                    (Figura 100). 
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Figura 100. Activación de la herramienta para crear una capa de anotación. 

A3. FUNCIONAMIENTO DEL BOTÓN 

Cuando se realiza la respectiva inspección de la Carta Catastral antes de generar el archivo pdf, 
se pueden presentar (como se mencionó anteriormente) inconvenientes con las etiquetas de la 
Nomenclatura Domiciliaria (Figura 101). 

 

Figura 101. Nomenclatura domiciliaria ilegible 

Cuando se presenten este tipo de casos el procedimiento a seguir es el siguiente: 

a) Minimizar la ventana Carta Catastral (Figura 102). 
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Figura 102. Botón para minimización de ventana de Carta Catastral. 

b) Clic en el botón             Esta acción desplegará el siguiente mensaje (Figura 103): 

 

Figura 103. Mensaje de creación de la capa. 

c) La capa creada se editará en el modo de Edición de Datos. Pasar al modo de edición de datos, 

dando clic en el icono ubicado en el entorno de ArcMap. 

 

Figura 104. Modo de edición de datos. 

d) Utilizando el botón Select Elements , se ubican las anotaciones en la posición deseada. 

Luego se retorna al Layout View dando clic en el botón  y se verifica la escala y la posición de 
la manzana dentro del formato (Figura 105). 
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Figura 105 Salida gráfica. 

e) Maximizar la ventana Carta Catastral y después clic en Generar pdf. (Figura 106). 

 

Figura 106. Generación de archivo PDF. 

 

Nota: Es importante recordar que cuando se termina de generar una Carta Catastral en la cual se 
realizaron ajustes a las etiquetas de la nomenclatura domiciliaria, la capa de anotaciones 
generadas de la carta catastral anterior permanecen activas y las etiquetas de la nomenclatura 
domiciliaria para la nueva manzana no están activadas. En el ejemplo anterior se generó la Carta 
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Catastral para la manzana No. 25740030000000021; ahora al realizar la generación para la 
manzana No. 25740030000000022 se observa que la nomenclatura domiciliaria activada es la de 
la manzana anterior. (Figura 107). 

 

Figura 107. Activación de Etiquetas nomenclatura domiciliaria. 

Por lo tanto es necesario realizar el siguiente procedimiento antes de generar el archivo pdf para la 
manzana No. 25740030000000022: 

a)  clic derecho en el ícono del Data Frame Carta Catastral y después en la opción(Figura 108). 

 
 

 

Figura 108. Visualización de propiedades de la data Frame. 
b) Cuando aparezca la ventana Data Frame Properties, ir la pestaña Annotation Groups y 

deshabilitar U_NOMENCLATURA_DOMICILIARIA, después clic en                       (Figura 85). 
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Figura 109. Desactivación de la nomenclatura domiciliaria ilegible. 

c) Clic derecho en la capa U_NOMENCLATURA_DOMICILIARIA y después seleccionar la opción 
Label Features (Figura 109). 

 

Figura 110. Verificación de las Etiquetas. 
 

d) Finalmente se realiza una verificación general y se procede a generar el archivo pdf. 
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Nota 9: Si se requieren realizar modificaciones a las etiquetas de otras capas diferentes a la de 
Nomenclatura Domiciliaria, es necesario emplear el procedimiento clásico en ArcMap, es decir, utilizando 

la opción Convert Etiqueta To Annotation  . El procedimiento a seguir es el siguiente: 

I. Clic derecho sobre la capa a la cual se desea convertir las etiquetas a Anotaciones y después 

clic en Para el caso del ejemplo se va a utilizar la 
capa de Nomenclatura Vial (Figura 111). 

 

Figura 111. Convertir Etiquetas en anotaciones. 

II. Paso seguido aparecerá el cuadro de dialogó Convert Labels To Annotations. En la sección Store 
Annotation, seleccionar In the map; en create annotation for selection All features y oprimir 

(Figura 112). 
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Figura 112. Cuadro de dialogó Convert Etiqueta To Annotations. 

III. Por último se siguen los procedimientos de los numerales (c y d) de la sección A3 
FUNCIONAMIENTO DEL BOTÓN, consignados en este documento. 


